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LEARNING OBJECTIVES 
 
Knowledge - to be able to; 

1. Have an understanding of the basics of photography, including the terminology and the 
effects on the photo outcomes by each setting. 

2. Have an understanding of the equipment required in digital dental photography. 
3. Have an understanding of the requirements of clinical photos. 

 
Skills - to be able to; 

1. Cooperate and communicate with the DSA and patients during the photo taking 
procedures. 

2. Take intra-oral clinical photos of equipment quality. 
3. Self-evaluate the quality of the photos taken, and figure out the possible ways to 

improve. 
4. Process the clinical photos taken to improve the quality. 
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1. BASICS OF PHOTOGRAPHY 
 
There are several items to be considered in photography, including: 
1) depth of field,  
2) exposure,  
3) colour spaces, and  
4) white balance calibration.  
 
Depth of field 
 
Cameras cannot focus everything within the image (Fig. 1.1). Depth of field determines which 
parts of an image are in sharp focus, and the extent of focus in front of and behind the plane of 
critical focus (the point to which the lens is focused).  
 

       
Fig. 1.1: Photos taken with different aperture sizes. Left was with standard aperture size of 

f22. Right was with aperture size of f2, in which the posterior teeth were not in focus. 
 
The depth of field can be adjusted by the focusing mode, and the aperture opening:  
 
On the other hand, depth of field varies inversely with the aperture opening (f-number). The 
smaller the f-number, the wider the aperture opening, hence the smaller the depth of field (Fig. 
5). As close-up dental photography has a small depth of field, a small aperture opening is 
required so that as many teeth as possible can be in focus. However, over-reduction of aperture 
size can deteriorate the image quality due to diffraction, which causes a decreased resolution.      
 
Auto-focusing mode works well for the majority of situations, especially for the beginners. 
However, sometimes the dental environment can cause malfunction of the focusing 
mechanism, especially when bright teeth are surrounded by pink gingivae with a dark oral 
cavity. Switching to manual focusing is a solution if the pictures are constantly out of focus.   
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Exposure 
 
Exposure explains how much light reaches on a digital sensor. It is a combination of: 
1. lens aperture size,       
2. shutter speed,       
3. sensor sensitivity, and  
4. the illumination from the flashlight. 
 
Aperture size controls the light intensity. For clinical photography, we generally use a f-number 
of 22 (i.e. f22). The larger the aperture size (i.e. smaller f-number), the more the light can act 
on the digital sensor (Fig. 1.2 and Fig. 1.5). It will result in a brighter photo.  
 

 
Fig. 1.2: Photos taken with different aperture sizes. Left was with standard aperture size of 
f22. Middle was with aperture size of f5, which appeared over-exposed. Right was with an 

aperture size of f32, which appeared dark. 
 
Shutter speed is the length of time the shutter remains open when the shutter release is 
activated, expressed in fractions of seconds. The shutter speed should be fast enough to prevent 
image blurring due to patient movements or camera shake (i.e. the shorter the shutter speed, 
the less likely the image will blur) (Fig. 1.3 and 1.5). However, as shutter speed also controls 
the duration of light acting on the digital sensor, the photos will become darker if the shutter 
speed is too short. The shutter speed we use clinically is usually 1/125s or faster. 
 

 
Fig. 1.3: Photo taken with a shutter speed of 4 seconds, which was blurred due to camera 

shake. 
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Sensor sensitivity is expressed in ISO number on the camera setting. The sensor sensitivity to 
light will increase together with the ISO number (Fig. 1.4). However, an increased ISO number 
also reduces the image quality by introducing noise or grain (Fig. 1.5). The ISO setting we use 
is 100 or lower. 
 

 
Fig. 1.4: Photos taken with different ISO numbers. Left was taken with a low ISO. Right was 

taken with a high ISO. Can you guess the numbers? 
 

 
Fig. 1.5: The effects of different values of the aperture size, shutter speed and sensor 

sensitivity on a photo. 
 
The intensity of illumination can be adjusted on the flashlight setting. The photo will appear 
brighter with a stronger emitted output. 
 
Color spaces and White balance calibration 
 
They control the illustration of color in the photo. Since they are not the settings that commonly 
require adjustments, details of them will not be discussed. For more details, please refer to 
‘Digital dental photography’ series by I. Ahmad published in the British Dental Journal in 2009 
(https://www-nature-com.eproxy.lib.hku.hk/articles/sj.bdj.2009.607.pdf). 
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Recommended camera settings for s standard dental set-up 
 

1. Focusing mode: Auto-focus 
2. Metering mode: Aperture priority 
3. Aperture: f22 
4. Shutter speed: 1/125 s or faster  
5. ISO: 100 or lower 
6. Exposure: Manual 
7. White balance: Auto 
8. With the ring flash/ macro flash on 

 

 
Fig. 1.6: Images showing the camera settings for intraoral photographs (flash turned on, M - 

mode, ISO/ F/ Shutter Speed adjusted).  
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2. EQUIPMENT  
 
Dental photography kit 
 
PPDH adopts the dental photography kit from Canon, which includes a digital camera body 
(Model: Canon EOS 80D), a macro lens and a macro flash (Fig. 2.1). 
 

 
Fig. 2.1 Canon EOS 80D camera for dental photography used in the clinic. 

 
Photo mirrors 
 
Mirrors can allow indirect photography at the areas which are inaccessible directly. In the 
clinic, there are two photo mirrors of different sizes. (Fig. 2.2). The rectangular mirror is used 
for taking clinical photos in the occlusal view, while the long mirror is used for buccal and 
palatal/lingual views. 
 
 

           
Fig 2.2: Mirrors of different sizes used in the clinic. Left are used for buccal and 

palatal/lingual views. Right are for occlusal views. 
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Cheek retractors 
 
Retractors are used to help access the zone to be photographed and maximize the illumination. 
(Fig. 2.3) Two sizes of plastic cheek retractors are available in the clinic. The larger size is used 
for adult patients while the smaller size is for paediatric patients. In cases of patients with small 
mouths, the smaller pairs of retractors can be used. The larger retractors are generally preferred 
because the lips can be retracted to a larger extent, in order not to cover the anterior teeth. (Fig. 
2.4). 
 

 
Fig. 2.3: Retractors. 

 

 
Fig. 2.4: Photos taken with cheek retractors of different sizes. Left was taken with larger 

retractors, in which the incisal edges of the anterior teeth could be captured. Right was taken 
with smaller retractors, in which the incisal edges of the anterior teeth were covered by the 

poorly retracted lower lip.  
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3. VIEWS REQUIRED 
 
In general, five views are required for the patient records, which include 1) Upper occlusal, 2) 
Lower occlusal, 3) Frontal, 4) Right buccal, and 5) Left buccal. 
 

 
Upper occlusal 

 

 
Right buccal Frontal Left buccal 

 

 
Lower occlusal 
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For periodontitis cases, nine views are recommended to record the gingival condition in the six 
sextants, which include 1) Frontal, 2) Right buccal, 3) Left buccal, 4) Sextant 03 palatal, 5) 
Sextant 04 palatal, 6) Sextant 05 palatal, 7) Sextant 08 lingual, 8) Sextant 07 lingual, and 9) 
Sextant 06 lingual. 

 

 
Sextant 03 palatal Sextant 04 palatal Sextant 05 palatal 

 

 
Right buccal Frontal Left buccal 

 

 
Sextant 08 lingual Sextant 07 lingual Sextant 06 lingual 
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4. SETTINGS IN THE CLINIC 
 
Operator preparation 
 
Before taking clinical photographs, patients’ consent should be obtained, especially when 
extraoral photos are taken. For paediatric patients, consent form can be given to parents or their 
guardian. 
 

 
Fig 4.1.1: Sample consent form for clinical photos from the Prince Philip Dental Hospital and 

the Faculty of Dentistry, Hong Kong, SAR. 
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Rationale of photos-taking should be explained to patients. Planning images to be taken and 
the sequence of shooting based on the individual case will bring greater patient comfort and 
operator efficiency. Mentally preparing the patient for how long it takes and how many views 
are needed is also important.  
 
Before taking the photos 
 
The field in interest should be cleansed from any dirt and impurity which include saliva, plaque, 
food debris and blood. Remove them gently to induce as little bleeding as possible. Cosmetics 
and stain from lipstick on teeth should be removed as well.  
 
To enhance patients comfort, you may ask them to lick their lips before retractor placement. 
Then, check if the mirrors are clean from water stain. If there is any, you can wet a gauze with 
water to clean the surface.  
 
Patient preparation 
 
The patient should be seated in a supine position, with their chin tilting up, at a 90-degree angle 
to the camera. The chair height should be adjusted according to the operator's height. 
Demonstration below shows how a suitable chair position brings more stable photos quality.  
 

  

Fig. 4.2: Un-ergonomic and unstable 
operator on tip toes and leaning forwards 

when the dental chair is too high. 

Fig. 4.3: Stable and comfortable position 
for the operator. 

 
When the nurse has no spare hands after mirror placement, you may ask your patient to help 
hold retractors. You should instruct them to hold the retractor outwards and a bit downwards.  
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Fig. 4.4: Patient helps in holding retractor before occlusal mirror placement.  

 
You can encourage your patient to breathe through their nose instead of mouth to reduce 
fogging on the mirror. Reminding your patient to relax their cheek muscles, lips and tongue 
will make retractor and mirror placement easier and more comfortable too.  
 
When taking the photo 
 
To prevent moisture build-up, there are a few methods you may employ. They are pre-heating 
the mirror, using salivary ejector, using 3-in-1 air-blow to prevent moisture build-up on the 
mirror. 
 

1. Preheating the mirror by soaking the mirror in hot water but be careful not to burn the 
patient. Dry the mirror with a tissue towel (Fig. 4.5, 4.6). 
 

.  
Fig. 4.5: Preheating the mirror in the warm water bath. 
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Fig. 4.6: Left is the photo taken with the mirror preheated. Right is the photo taken 

with the mirror not preheated. 
      

2. Suction with saliva ejector but the camera may take more time to focus due to suction 
tip in field (Fig. 4.7). 
 

 
Fig. 4.7: Saliva ejector used to reduce fogging from patient’s breath and saliva build up. 

  
3.  Air blow with 3-in-1 syringe: air blow can work from distance, therefore not disturbing 

focusing of the lens but the saliva built up cannot be suctioned away. 
 
You should balance the use between suction tip and 3-in-1 according to the patient's salivary 
rate and camera focusing speed. One additional tip is to count from 1 to 3 before you press the 
shutter so your assistant knows exactly when to remove the saliva ejector from field.  
 
Although the mirrors will be held by the nurse, the operator should assist in the positioning of 
mirrors as the nurse cannot view from the same angle as the operator. The operator should 
visualize the area of interest on the mirror. Check if everything you wish to capture is reflected 
in the mirror. If not, assist the nurse in purchasing an optimal angle. Before shooting, final 
check if the nurse’s finger tip is in field and obstructing the area of interest.  
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Fig. 4.8: Assistant and operator position when taking frontal view. 

  

 
Fig. 4.9: Finger tip is captured in this image.  

 
Operator position 
 
The operator has to stand above the patient, at a 90-degree angle 

1. When taking Laterals (without mirror) → have the patient turn their head to the opposite 
side of what you wish to capture so their face is towards the photographer (e.g. if you 
wish to take the left side, ask the patient to turn their head to the right). 

2. When taking Laterals (with mirror) → Stand on the opposite side of what you wish to 
take, try to take this shot at a 45-degree angle to the mirror. 
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Fig. 4.10.1: Mirror placement for lateral 

view. 
 

 
Fig 4.10.2: Diagram describing the 45-

degree angle position of teeth-mirror and 
mirror to camera position. 

 
3. When taking Upper occlusal → use a retractor to pull the upper lip away from the teeth. 

Patient may tilt their head forward so photographer can get the camera 90-degrees to 
the mirror plane. 

4. When taking Lower occlusal → use a retractor to pull the lower lip away from the teeth, 
Patient may tilt their head backward so photographer can get the camera 90-degrees to 
the mirror plane. 

   
 

  
Fig. 4.11: Frontal / Occlusal view photos 

taking. 
Fig 4.12: Photo taking with the camera 

positioned above the patient. 
 

Occlusal and frontal views are aided by having the patient reclined. The retractors are held by 
either the patient or the assistant depending on the view taken. An assistant also holds the mirror 
(if required) and keeps the mirror from fogging with the appropriate equipment (e.g. 3-in-1/ 
suction). The photographer stands over the patient to capture the occlusal views, above the 
patient for maxillary and below the patient’s head for mandibular. 

 
 
  



 

18 
 

Mirror and retractor placement 
 

1. Frontal view→ use the retractors to pull the cheek and lip out of the teeth, pull outward 
and upward. 

 

 
Fig 4.13: retractors placement in frontal view. 

 
2. Lateral view → retractor is loosely placed on the opposite side to hold the lips in 

position without stretching the lips. Buccal mirror is inserted as far back as it can until 
the posterior border lies distally of the last tooth in the vestibule, angling the mirror 
outside the side of posterior teeth. 

 

 
Fig 4.14: retractor and mirror placement in lateral view. 

 
3. Occlusal view (lower) → use the retractors to pull the lip and cheek out, forward and 

downward. The palatal mirror is inserted with the broader end toward distal in the case 
of adults. The Patient is asked to raise the tongue to the palate and the mirror helps to 
retract the tongue. If patients find it is difficult, ask the patients to keep the tongue down 
and relax. The mirror rests on the gingiva of the last molars. It is turned upwards with 
the mouth wide open until it touches the incisal edges of the upper incisors. 

 
4. Occlusal view (upper)→ use the retractor to pull the lip and cheek out, forward and 

upward. The palatal mirror rests on the gingiva distally of the last molars and turned 
down as far as possible until it touches the lower incisors. 
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Fig 4.15: retractor and mirror placement in 

upper occlusal view. 
    Fig 4.16: retractor and mirror placement 

in upper occlusal view. 
            

5. Palatal/ lingual view of the posterior teeth→ use the retractor to retract outward and 
upward for upper palatal, retract outward and downward for lower lingual. Buccal 
mirror is placed distal to the final tooth to be photographed, inclined sideways, and 
rotated along its longitudinal axis until it is possible to take the photograph. 

 

  

Fig 4.17: retractor and mirror placement in 
upper lingual view of posterior teeth. 

Fig 4.18: retractor and mirror placement in         
lower palatal view of posterior teeth. 
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5. PHOTO JUDGMENT 
 
At chairside, the operator should be able to evaluate a photo to see if it needs to be retaken on 
the spot. As much as software adjustments can enhance the photo quality to make it more 
presentable, not all defects can or should be digitally modified. A nicely taken photo not only 
allows you to present a more authentic image with minimal digital enhancement, but also saves 
both the operator and patient’s time from having to retake photos in another appointment. Here 
are a few pointers in immediate photo assessments.  
 
An acceptable image should consist the followings: 

1. Level of image clarity that is sufficient for identifying clinical features.  
2. Correct color rendition should be as close to the original oral tissues. It is crucial in both 

for identifying pathologies and communicating with technicians the shade selection 
when ordering for restorations and prostheses. Please refer to the previous chapter 
(BASICS OF PHOTOGRAPHY) for camera setting instructions to ensure this aspect 
to be accurate.  

3. Sufficient hard and soft tissue should be captured with details.  
4. Appropriate camera angulation with minimal rotation and tilting. The angle of the 

camera and the capturing surface should be kept as close to 90 degrees as possible.  
5. When taking frontal and lateral buccal views, the two arches should be closely 

occluded.  
6. Cheeks should be sufficiently retracted to ensure maximum exposure of intra-oral 

tissues. 
 
Such features will be demonstrated with images in later sections “COMMON OBSTACLES” 
and “EXERCISE”. 
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6. POST-IMAGE CAPTURE PROCESSING 
 
It should be remembered that dental images are dento-legal documents, so manipulation of the 
original image should be kept to a minimum. They should not mask any pathology or alter what 
was present in the oral cavity. 
 
Currently there are many softwares available for post-processing. Adobe Photoshop and 
Microsoft PowerPoint were used as examples here to demonstrate post-processing of dental 
images. 
 
Before any post-processing, it is recommended to keep a copy of the original image as backup 
in case anything goes wrong. 
 
Checking alignment 
 
Any minor tilting of the image can be identified with the help of auxiliary lines. 
 
Photoshop 

- Click “View” → “Rulers”. 
- Drag a “Guide” from the vertical/horizontal ruler to the desired position. 

 

 
 

- Tips 
- More than one guides can be created. 
- To hide/show the guides, click “View” → “Show” → “Guides” or “Canvas 

Guides”. 
- To remove the guide, drag it back to the ruler; or click “View” → “Clear 

Guides” to remove all the guides. 
 
  



 

22 
 

PowerPoint 
- Hold Shift key when drawing a straight line to make it vertical/horizontal. 

 

 
 
In this example, anticlockwise tilting is identified, which can be corrected by rotating the 
image. 
 
Rotation 
 
Photoshop 

- Click the Crop tool on the left toolbar. 
- Move the cursor to around the corner of the frame and it will turn into a “rotate” icon; 

rotate the image clockwise/anticlockwise. 
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- After rotation, click Enter to crop the image. 
 

 
 

- Alternatively, you can also click “Image” → “Rotation” → “180°”, “90° Clockwise”, 
“90° Counter Clockwise” or “Arbitrary” to rotate the image. 
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PowerPoint 
- Click on the image and move the cursor to the “rotate” icon; rotate the image 

clockwise/anticlockwise. 
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- If you want to crop the rotated image, first copy the image and then right click on any 
blank space; click “Paste Special” and select to paste as “Picture”. You will now be 
able to crop the rotated image. 
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Flipping 
 
If a mirror was used during photo taking, the image will be inverted laterally, and they need to 
be flipped back to reflect the actual clinical situation. If you are not sure about whether the 
image should be flipped or not, you can compare it with the frontal view and clinical charting 
to verify. 
 

  
 
For example, this patient presents with lingually positioned #31 as shown in the frontal view. 
Therefore, it should be a left buccal view, and the photo should be flipped horizontally. 
 
Photoshop 

- Click “Image” → “Image Rotation” → “Flip Canvas Horizontal” or “Flip Canvas 
Vertical”. 
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PowerPoint 
- From “Picture Format”, click on the rotation icon and select “Flip Horizontal” or 

“Flip Vertical”. 
 

 
 
Cropping 
 
It is beneficial to include a little bit more view during photo taking to allow more room for 
adjustment, especially during rotating, cropping and enlarging/reducing images. 
 
Cropping is needed: 

- After rotating the image, 
- When enlarging/reducing images to achieve similar object sizes among photos, 
- To bring symmetry to the image, and 
- To remove any superfluous pixels. 
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Photoshop 
- Select the Crop tool on the left toolbar (see “Rotation” above). 
- To maintain a fixed aspect ratio during cropping, you can either: 

- (1) Select “Original Ratio” on the top toolbar, or 
- (2) Hold Shift key when dragging the frame. 

 

 
 

- Crop the image accordingly; you can also drag the image to move it 
vertically/horizontally. 

 
PowerPoint 

- From “Picture Format”, select “Crop”. 
- Hold Shift Key to maintain a fixed aspect ratio when dragging the frame. 

 
Putting them all together! 
 
Next, try to position the photos of all different views in a single layout to compare the relative 
object sizes and alignment of the images. Any further rotation, cropping and 
enlargement/reduction of the images may be needed. It is recommended to perform this step in 
PowerPoint due to ease of use and its “auto-align” feature. 
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PowerPoint 
- Insert all the required photos into a single blank slide. 
- From “Picture Format”, tick the box “lock the aspect ratio” so that it will not change 

when you enlarge/reduce the image. 
 

 
 

- Align your images. Make further adjustments including rotation or cropping or 
enlargement/reduction as needed. 
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Exporting the images 
 
If you are satisfied, the next step is to export the images. It is important to maintain the original 
dimension and resolution of the image as much as possible. To achieve this in PowerPoint, the 
following steps could be performed: 

- Double click on the image, and the “Format Picture” box will appear on the right. 
- Click on the “Size & Properties” tab (third from left). 
- You can either: 

- (1) Click “Reset” under “Original size”, or 
- (2) Tick the box “Relative to original picture size” and change Scale Height 

and Scale Width to 100%. 
 

 
 

- Then right click on the image and select “Save as Picture” to export the image. 
- However, it should be noted that there will still be some loss of image quality. 
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If you want to change the actual dimensions of the images, you can follow the steps below: 
- In PowerPoint, either reset the images to their original size, or scale all images to 100% 

as mentioned above. 
 

 
 

- Identify the image with the smallest dimension (which is the lower occlusal view in this 
example); reduce the rest of the images to this same dimension. 
 

 
 

- Export the images as mentioned above. 
 
  



 

32 
 

Before and after 
 
Before 

 
 
After 
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Other tools 
 
Tools such as Brightness and Contrast, Levels, Curves, Exposure, Hue/Saturation, and Color 
Balance are also available in Photoshop. However, if the images are taken with good techniques 
as mentioned before, a lot of time could be saved for any adjustment afterwards. 
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7. COMMON OBSTACLES 
 
Camera setup 
 
Memory card cannot be read or used 

1. Ensure you are using an approved memory card. 
2. Confirm the card is correctly inserted. 
3. Take the card out, make sure the contacts are dust free and re-insert the card. 
4. If the above measures fail to resolve the issue, try another memory card. 

 
Memory card is write-protected 
Remove the memory card and check if the write-protect switch is in the “locked” position. To 
solve the problem, move the write-protect switch to the “write” position and re-insert the 
memory card. The error message should disappear. 
 
 

  
Fig. 7.1: Ensure the memory card is switched to the "write" 

position to enable photo storage. 
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Patient setup 
 
Fogged mirror 

1. Ask patient to breathe through their nose. 
2. Defog the mirror i) by warming the mirror with hot water bath, ii) with an air syringe, 

or iii) with a saliva ejector. 
 
Difficulties with retractor placement 

1. Ensure the correct-sized retractor is selected depending on patient’s mouth size and 
muscle tightness. 

2. Apply Vaseline on patient’s corners of mouth for comfort during lip retraction. 
3. Wet retractors so that they can be slid into patient’s mouth with ease. 

 
Lips obscuring gingival tissues or anterior teeth to be captured 
The lips are likely under-retracted in this case. Select larger-sized retractors and encourage 
patient to retract their lips as far as possible. 
 

 
Fig. 7.2: Use of properly sized retractor (pictured left) allows a better capture of mucosal and 

gingival tissues than a smaller sized retractor (pictured right). 
 
Patient not biting in proper occlusion 
Instruct the patient to swallow and bite at ICP to ensure the correct occlusal relationship is 
maintained for image capture. 
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Camera settings 
 
Black image. Help! 

1. Check if you have uncapped the lens. 
2. Ensure the external flash is fully recharged between captures. 

 
Anterior teeth are clearly captured but posterior teeth are blurred 
The aperture size is likely too large. The recommended aperture size is f22 or smaller to allow 
as many teeth as possible to be in focus. 
 

  
Fig. 7.3: Choosing a smaller aperture (f22, pictured left) allows better depiction of posterior teeth 

than when a larger aperture is selected (f5.6, pictured right). 
 
Overexposed image 
Confirm if the recommended camera settings are followed. An overexposed image can be due 
to 1) aperture size too large, 2) shutter speed too slow, or 3) ISO too high. 
 
Underexposed image 
Confirm if the recommended camera settings are followed. An underexposed image can be due 
to 1) external flash not operating normally, 2) aperture size too small, 3) shutter speed too fast, 
or 4) ISO too low (which is less likely in the clinic setting). 
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Shaky image 
1. Check if the Image Stabilizer (IS) on the camera lens is switched on (Fig. 7.4). 
2. Ensure the external flash is operating properly and there is sufficient background light. 
3. Confirm if the recommended shutter speed is followed; increase the shutter speed if 

necessary. 
 

 
Fig. 7.4: Auto/manual focus switch and Image Stabilizer switch located on a Canon lens. 

          
            

  
Fig. 7.5: A faster shutter speed (1/125", pictured left) compensates for operator or patient movement 

than when a slow shutter speed was used (4", pictured right). 
 
Camera not in focus when using the Auto Focus (AF) setting 

1. Make sure you are not too close to the subject. The minimum focusing distance for the 
Canon EF 100mm f/2.8 USM Macro Lens is 0.3m. 

2. Remove obstacles that would inhibit focusing e.g. water droplets on mirror, suction 
tips. 

3. If the above measures fail to resolve the problem, try focusing with Manual Focus (MF). 
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Capturing technique 
 
Unable to capture posteriors 
Ask patient to relax their lips, cheeks and tongue to allow the mirror to be inserted more 
posteriorly. Visualize the area of interest on the mirror to ensure the area of interest is reflected 
on the mirror before capturing. Confirm that the mirror is placed at a distance from the most 
posterior teeth instead of resting directly on them. 
 

  
Fig. 7.6: Placement of mirror away from the dentition (pictured left) allows a better capture of 

posterior teeth than when the edge of the mirror is overlying the posterior dentition (pictured right). 
 
Image is slanted superoinferiorly or laterally 
Ensure the mirror is placed parallel to the dentition and the lens is capturing at an angle 
perpendicular to the dentition or the reflected mirror image, but not from an angle above or 
below the plane. 
 

  
Fig. 7.7: Examples of images captured from an angle too inferiorly (pictured left) and too far right 

(pictured right). 
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8. EXERCISES  
 
The following are a number of unprocessed photos to demonstrate some practical parameters 
for assessments.  
 

 

Exposure: 
Details: 
Angulation:  
Occluded?: 
Others: 
 
 
Accept/ Retake? 

 

Exposure: 
Details: 
Angulation:  
Occluded?: 
Others: 
 
 
Accept/ Retake? 

 

Exposure: 
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Occluded?: 
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Accept/ Retake? 

 

Exposure: 
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Exposure: 
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Accept/ Retake? 

 

Exposure: 
Details: 
Angulation: 
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Others: 
 
 
Accept/ Retake? 

 

Exposure: 
Details: 
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Occluded?: 
Others: 
 
 
Accept/ Retake? 
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Exposure: 
Details: 
Angulation: 
Occluded? 
Others: 
 
 
Accept/Retake? 
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